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Introduction 
 
This hands-on guide will help introduce you to the RISA-3D Wood Wall Panel functionality, while also walking you through a 
start to finish example, including helpful tips and tricks along the way.  This tutorial is intended for both experienced and first-
time RISA-3D users and can be completed in a single sitting. 
 
All the “actionable steps” in this tutorial are indicated with bullets as shown below:

• Actionable Step 

This guide is intended to show teach the basics of the wood wall panel functionality.  If you have further questions that fall 
outside of the scope of this guide, please refer to the RISA-3D General Reference Guide and the online Help file. 

Note: If you are not familiar with RISA-3D, you should also complete the tutorials available on the RISA website at 
https://risa.com/documentation. 

The RISA-3D Wood Wall Panel: Introduction & Tutorial is compatible with RISA-3D v18 or higher. 
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Wood Codes & Materials 
Let’s start by setting the design code: 

• Click on the Model Settings  icon. 

• Choose the Codes tab. 

• Select the Wood code from the drop-down list: AWC NDS-15: ASD. 

• Click OK. 

 

Next, let’s create the material for the wood wall: 

• Click on the Materials button on the Data Entry Toolbar:  

 

• Click on the Wood tab at the top of the dialog box 

• We’ll use DF. 

 

 

• Click  to close the spreadsheet.   

Wood Design Codes in RISA-3D: 

• AWC-NDS-18/15/12:ASD 

• AWC-NDS-18/15:LRFD 

• AF&PA NDS-08/05/01/97:ASD 

• CSA-O86-14/09: Ultimate 

The wood species available can be 
found by clicking in the Species 
column in the Materials spreadsheet 
and clicking on the dropdown arrow. 
The list is organized with all the 
species available in the NDS first, and 
the Glulam types at the bottom. If you 
add your own Custom Material 
Species, you will find your new 
species name located between the 
NDS wood species and the glulam 
types. 
 
 
Custom Wood Species can be 
created by opening the Custom 
Wood icon found on the Advanced 
tab. 

 

 
 
 

 

TIP: RISA-3D has a variety of default 
material properties available; you can 
save your own default materials  
by pressing the Save as Defaults   
icon at the top of the screen  
when the Materials spreadsheet  
is open. 

 

 
 
 
 
NOTE: If you don’t see the DF label 
in your Wood Materials spreadsheet, 
you may use the available species or 
go to File > Application Settings > 
General > Advanced > Reset all 
Program Defaults to get all the wood 
species defaults for v16 or higher.  
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Creating Wall Geometry 
Let’s start by drawing the wall: 

• Click on the  icon on the Draw Elements section of the Toolbar.  

• You should now see the Properties Panel update with design properties 

specific to Wall Panels: 

 

 

You can draw a wall by clicking on existing nodes or drawing the wall using a 

grid. We’ll draw a wall using the drawing grid.  

Choose which type of wall: 

• Select Wood from the drop-down menu. 

• Select Material Set: DF 

• The mouse cursor will appear with crosshairs              and you are ready to 

start drawing. 

 

 

 

 

 

 

 

 

 

You must first define the material you 
want to use.  The current options 
available are Masonry, Wood, 
Concrete and General.  In this 
exercise, we will be drawing a wood 
wall. 
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Using the drawing grid to create a 12’ high rectangular wall: 

• Click on the bottom left corner (0,0,0),  

• Move the cursor to the top right corner and left click on (16,10,0),  

• Right-click the mouse or press Esc to stop drawing. 
 

 

The wall panel will be created after the second click of the mouse and should 

look like the picture above.  

Let’s change the Units to inches: 

• Click on the Units  icon on the Home tab. 

• Under Length, click on the dropdown menu and select inches 

• Click OK. 
 

 

 

 

The Drawing Grid will help you draw 
the wall. As the cursor hovers over 
the drawing grid intersection lines, a 
red dot will appear which indicates 
where the joint will be located.   

 

If the grid is not visible, click the 
icon in the Drawing Tools tab.  

 

Notice that you can view the cursor 
coordinate information when you 
hover over an existing node or 
drawing grid intersection.  
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Let’s open the Wall Panel Editor to add openings: 

• Double click on the Wall Panel to view the Wall Panel Editor. A new Walls 
tab will appear in the Ribbon Toolbar. 

 

 

Next, let’s change the drawing grid to locate the openings:  

• In the Drawing Tools section of the Walls tab, click in the box next to 
Horizontal (in), clear the current entry and type 40, 32, 3@40 

• In the Drawing Tools section of the Walls tab, click in the box next to 
Vertical (in), clear the current entry and type 3@40 

• Press the Tab key to complete the input. 

The grid will automatically resize to adjust to the new scale. You can also toggle 

the grid display on and off by clicking the         icon. 

  

 

 

 

The drawing grid within the Wall Panel 
Editor is a tool that guides your 
placement of openings, hold-downs, 
straps, and boundary conditions.  The 
grid is independent of your model, so 
you may change the grid as you build 
the wall without changing anything in 
your model. 

 

 

 

 

 

 

 

 

 

 

Note: In the Drawing Grid, you may 
use symbols such as: 

 “@” (to specify multiple, equally 
spaced increments). 

  “/” (to subdivide a larger increment 
into smaller increments). 

 “,” (to enter multiple increments in the 
increment field). 
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With the grid set, create a window and a door opening: 

• Click on the Openings             icon at the top left of the Wall Panel Editor 
to create an opening. 

Let’s create the door opening: 

• Using the Wall Grid coordinates, left click on the bottom left corner of the 
opening (40,0)  

• Move the mouse to the top right corner (72,80) and left click on the grid 
intersection. 

Now let’s create a window opening:  

• Left click on the bottom left corner (112,40) 

• Move the mouse to the top right corner (152,80) and left click on the grid 
intersection. 

• Right click to end the command. 

 

Now we can add boundary conditions (supports): 

• Click the Create New Boundary Conditions  icon in the top left of 

the Wall Panel Editor 

• For this wall panel, we will choose the Pinned  support option.  

Additionally, since the support is being assigned within the Wall Panel 
Editor, the boundary condition will be assigned as Continuous along the 
edge of the wall panel. 

• Select a node along the bottom edge of the wall panel to apply the 
boundary condition. 

 

• Right click to end the command. 

Wall Panels can have rectangular 
openings. You can click on any 
location on the grid to create an 
opening.  
 
Openings can be created anywhere 
on the wall panel except the upper 
and side edges. 

 
Note: You can utilize the Delete 
tool to remove the openings if 
you make a mistake.  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Other boundary conditions can be 
used.  It is possible to modify all six 
degrees of freedom in the model 
(translation in X, Y and Z and rotation 
in X, Y and Z).  The preset options for 
boundary conditions include: 

• Free 

• Fixed 

• Roller 
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Headers 
Let’s review the header design parameters: 

• Double left click directly inside the window opening to view the header 
design parameters, in this example select Edit/View Existing Wall Design 
Rule. 

 

 

• If the headers do not show, use the toggle  icon to turn them on. 

The header selection is based on the design rule assigned in the Wall Panel 
Design Rules or you can create a Custom Opening where each opening within  
the wall is defined separately. 

 

 

 

• Click Cancel. 

 

We will review the header Design Rule in the next section. 

Headers will automatically be created 
and placed above the openings in 
wood walls. 
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Assigning Design Parameter 
Regions 
Let’s define regions inside the wall for design/analysis of the 
wood shear wall: 

• Select the Generate Wall Regions Automatically  icon. 

 

The wall drawing should now look like the picture above. 

You can use the Wood View Controls to Toggle the display of the following: 

− Wall Studs  

− Chords  

− Sill Plates  

 

• Click  to exit the Wall Panel Editor 

 

 

 

 

 

 

 

 

 

What is a Region?  
In RISA, we define a wall strip for 
design as a Region. In reference 
codes this is referred to as a full height 
wall segment or pier.  

Regions must be rectangular. To 
create them, use the cursor to select 
two nodes or grid intersections which 
define the lower left corner and upper 
right corner of the region. 

Note: Regions cannot overlap 
openings. 

RISA automatically creates regions for 
walls. However, it is also possible to 
manually create Regions by  
selecting Design Wall Regions 

Manually icon.        .  

 

 

 

To design a Segmented Wall, a region 
must be defined for every piece of the 
wall. 
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Wall Design Rules 
Let’s review the Design Rule from the Properties Panel of the 
wood wall. 

• Select the wood wall and click on the ellipsis  button next to the 

design rule. 

• Click Edit/View the Existing Wall Design Rule and set the wall panel 

design parameters as shown in the dialog below. 

 

 

The dialog allows for all of the wall design parameters to be assigned and 

modified in one location. 

• Click OK when you have assigned the parameters correctly. 

 

 

 

 

 

 

 

Stud design is accomplished by 
taking the entire axial load in the wall 
and dividing it by the number of 
studs.  The spacing is optimized 
based on the range in the Design 
Rules (Studs) spreadsheet. 
 

 

Optimizing the Wall Panels 

RISA will design and optimize the wall 
panels based on the criteria in the 
Wall Panel Design Rules.  
 
Additionally, there is an option in the 

Model Settings  that will 

enable optimization of walls upon 
solution.  If you want to check an 
existing wall, you can explicitly select 
the wall panel size and make sure to 
turn off the wall optimization. 

 

The Wood Wall Panel Schedule and 
Hold Down Schedule are based on 
an XML file database.   

 

The Wood Wall Panel Schedule 
database is specified by an XML file 
in the Shear Panels folder, a sub-
directory of the 
RISA_Wood_Schedules folder 
located in the C:\RISA folder.  
(This defaults into the C:\RISA folder, 
but you can also find the directory 
location by going to File > Application 
Settings > File Locations) 

 

The Hold Down Schedule database 
is specified by an XML file in the 
HoldDowns folder, a sub-directory of 
the RISA_Wood_Schedules folder. 

 

The wall panel design is optimized 
based on the shear capacity. The 
shear demand is determined for the 
wall, and the panel is chosen with the 
closest shear capacity. 

 

You can select an entire series or list 
of panels or select one panel by 
clicking on the Label. 
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Wall Panel parameters can also be assigned directly in the Wall 
Panel Design Rules spreadsheet. 

• Select Wall Design Rules from the Data Entry panel. 

 

• Click on the Wood Wall (Studs) and Wood Wall (Fasteners) tabs 

• Click  to exist the Wall Design Rules 

To better view the wall, in the 3D view, click on the Rendered Icon        found in 

the Quick View section of the Home tab twice and the Snap to Isometric view 

option ISO. 

 

 

 

 

 

 

 

 

 

 

It is possible to modify the existing 
databases or create new databases at 
any time.  For more information on the 
formatting requirements, refer to the 
Appendix F Wood Shear Wall Files in 
the Help Menu of RISA-3D. 

 

 

 

Note: If you want to view the wall 
panel rendered at 100%, click on the 
Model View Settings button               
and click the Wall Panels tab           
and select 100% using the  
sliding scale. 
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Loading 
We first need to create the Basic Load Cases: 

• Open the Basic Load Case spreadsheet on the Data Entry toolbar or 
press the             icon. 
 

• Type Dead Load on the first line under the BLC Description column. 

• Select DL (Dead Load) from the Category drop-down menu. 

• Type -1 into the Y Gravity column. 

Let’s add wind load case: 

• Type Wind Load on the second line under the BLC Description column. 

• Select WL (Wind Load) from the Category drop-down menu. 

 

• Exit BLC Spreadsheet by clicking the  on the top right corner. 

Add a distributed load to the wood wall: 

• Click on Distributed Load          icon. 

• Select Y for Direction in the drop-down menu. 

• Select Basic Load Case 1: Dead Load. 

• Type -0.1 as the Start Magnitude and the End Magnitude will 
automatically populate. 

 

• Press Click to Apply and then click on the top of the wall. 

 

 

 

 

 

 

 

Walls can be loaded with joint, 
surface loads, or distributed loads.    
 
You must define the Category to use 
the Load Combination Generator. 
 
Typing a -1 in the Y Gravity column 
creates a Basic Load Case which 
includes self-weight. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can end any command by right 
clicking the mouse. 
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The wall should now look like the image below with the distributed load applied. 

 

Let’s add a point load of wind load to this wall: 

• Click on Nodal Load          icon. 

• Select LOAD (L). 

• Select Basic Load Case 2: Wind Load. 

• Select Direction X from the dropdown list. 

• Magnitude: 2 kips 

• Select Click to Apply. 

 

• Click on or draw a box around Node N2. 

 
The wall should now look like the image below with the point load applied. 

 

 

 

 

 

Nodal loads can only be applied in 
the global directions.  We can tell that 
this is the global axis because the X 
is capitalized. 
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Load Combinations 
Let’s create the load combinations using the LC Generator: 

• Open the Load Combination spreadsheet by selecting the                icon 
at the top of the screen. 

• Select LC Generator  

• Select United States for the LC Region. 

• Select 2018 IBC ASD for the LC Code. 

• Uncheck RLL, SL and RL 

• Click Generate to create gravity load combinations 

• Click on Wind tab 

• Click the 2D Only button under Wind Load Options 

• Check the Reversible option. 

• Click Generate 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Click Close 

 

 

 

 

 

The LC Generator allows you to create 
load combinations quickly based on 
the code you select. 
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The Load Combination spreadsheet will automatically generate all the load 

combinations from the IBC 2018 and should look like the picture below: 

 

• Close the LC spreadsheet. 

Let’s review the loads as they are applied to the wall: 

• Toggle on the loads display by clicking the         icon if they’re not already 

turned on. 

• The load display control panel is on the top of the screen. 

 

• Click on the drop-down menu to switch Type to Load Combination. 

• Select the LC6 in the drop-down dialog. 

You should now see the Load Combination 6: IBC 16-12 (a) (a) = DL + 0.6WL 

displayed on your screen as below. 

  

• Enable 2D mode by selecting the 2D Lock              icon at the top of the 

3D view. This will provide out-of-plane stability. 

 

 

 

 

 

 

 

 

 

 

To display loads, we will work with the 
loading display toolbar at the top of 
the screen. 
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With all the loads applied, let’s run the analysis: 

• Click the Analysis and Design           icon. 

• Select the Batch Solution of Marked Combinations radio button. 

• Click Solve. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
A Single solution will only solve the 
selected load combination. An 
Envelope solution will solve multiple 
load combinations and the results will 
show only the maximum and 
minimum. The Batch solution will 
solve multiple combinations and the 
results will be retained for every 
solution.   
 
 
The Detail Report is only available for 
Single Combination solutions or 
Batch solutions. 
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Designing the Wall: Segmented 
Method 
Reviewing results: 

• Select the Wall Panel Design spreadsheet from the Results toolbar. 

 

• To view the different results for wall panels, click on the tabs at the top: 

Wood Wall Axial, Wood Wall In-Plane, Wood Header 

The Wood Wall Axial results provide the code checks relevant to axial loads of 

the wall. 

 

 

 

 

 

− The Wall Panel Label and Region correspond to the wall panel labels 

and regions defined in the Wall Panel Editor. 

− The Stud Size and Stud Spacing correspond to the studs selected and 

spacing range in the Design Rules. 

− The Axial Check is a code check ratio between the member load and 

the member capacity. A value greater 1.0 for either of these values 

indicates failure. The Gov LC shows the load combination that governed 

for the code check. 

− The Chord Size corresponds to the chord selected and spacing range 

in the Design Rules. Note that the chords are the vertical hold down 

members/posts at both ends of every Region. 

− The Chord Axial Check is a code check ratio between the member load 

and the member capacity.  A value greater 1.0 for either of these values 

indicates failure. The Gov LC shows the load combination that governed 

for the ratio mentioned above. 

 

 

 

Design Methods 

Segmented: A wall is broken up into 
separate full-height regions or 
segments and designed separately. If 
the shear wall has openings, the area 
above and below the openings are 
disregarded. 

Perforated: The total shear is applied 
to the wall and is divided by the width 
of the full height sections of your wall. 
There are many limitations as to when 
the Perforated Method can be applied, 
refer to the NDS 2005, Special Design 
Provisions for Wind and Seismic 
4.3.5.3.  

Force Transfer, FTAO:  This method 
allows you to use the entire area of 
the wall minus the openings to resist 
the shear in the wall. The framing 
around the openings is reinforced for 
this method. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: The chords are the vertical hold 
down members/posts at both ends of 
every Region. 



RISA-3D Wood Panel Tutorial 

17 

 

The In-Plane results provide the code checks for the shear wall behavior of the 

wall. 

 

 

 

 

− The Shear Panel Label describes the shear panels selected for the wall.  

The designation NC indicates no calculation done on regions above 

and below openings. 

− The Shear Check is a code check ratio between the panel shear load 

and the panel shear capacity. A value greater 1.0 for either of these 

values indicates failure. The Gov LC shows the load combination that 

governed for the code check.  

− The Hold-Down Label describes the hold downsize selected for the 

wall.   

− The Chord Strap Label describes the chord strap size selected for the 

wall. 

− The Tension Check is a code check ratio between the tension load and 

the hold down provided capacity. A value greater 1.0 for either of these 

values indicates failure. The Gov LC shows the load combination that 

governed for the ratio mentioned above.   

• Close the Wall Panel Design spreadsheet. 

Let’s take a closer look at the wall by viewing the Detail Report: 

• Click the Detail button  on the left-hand side of the screen. 

• Click anywhere on the wall panel. The Detail Report Summary Report will 
open. 
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Wall Summary Detail Report 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

General/Geometry/Materials 
The top section of the detail report 
echoes the entire user defined input 
also summarizing the selections.  The 
shear panel selected is shown as 
well as the Maximum H/W ratio for all 
the regions. 

 
 
 
 
 
 
 
 
 
Wall Region Drawing 
This drawing shows the regions and 
openings with hold-down locations 
for your reference. 

 
 
 
 
 
 
 
 
 
 
 
 
Design Details 
The Enveloped Results will display 
the controlling region, with the 
maximum Unity checks for Shear, 
Hold-down, and Studs. The Region 
Information will show the unity 
checks for all the regions.  The 
openings are not design for 
Segmented walls.  The deflection 
results are shown for the FEA 
solution as well as the NDS 
calculation method. 
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Regions In-Plane Detail Report 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Criteria/Materials/Geometry 
The top section of the detail report 
echoes the entire user defined input. 

 

 

Envelope Diagrams 
The next section will display the 
envelope axial, shear and moment 
diagrams. 

 

 

 

 

 

 

 

 

 

 

 

Design Summary 
This section provides the capacity 
and strength values at the section in 
the wall where the combined check 
is maximum, as well as governing 
load combinations.  

The shear capacity is taken from the 
allowable shear value from the Table 
2306.4.1 of the IBC 2018.  The shear 
provided is adjusted by the 2w/h if 
the H/W ratio exceeds 2:1 per NDS-18 
Special Provisions for Wind and 
Seismic 4.3.4.1. 

The Deflection listed is based on the 
NDS-18 Special Provisions for Wind 
and Seismic Eq. 4.3-1. 

Note: This is the theoretical 
deflection of the wall and may differ 
from the deflection found from the 
FEA within RISA. 
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Let’s review the results graphically: 

• Double click on the wall to open the Wall Panel Editor and you’ll see the 

designed wall detailed with the chords, studs and shear panel information. 

Let’s take a minute to review all the different components that make up the wall 

element: 

 

  

 

 

 

 

 

 

 
 
 
 

 

 

 
 

Wall Panel View 

You can use the Wood View Controls 
to toggle the display of the: 

• Wall Studs  

• Chords  

• Sill Plates  

Note: You’ll notice the boundary 
conditions are only at the ends of the 
walls once you switch to Perforated 
method.  This is because the entire 
wall is considered at once in the 
Perforated Design Method without 
regions. 
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Designing the Wall: Perforated 
Design Method 
Let’s change the Design Method to Perforated: 

• We’ll now switch the Design Method to Perforated in the Advanced 

Properties in the Properties Panel. 

 

 Note: Select Yes when asked to clear the current results. 

With the loads still applied, run the analysis: 

• Click the Analysis and Design  Icon. 

• Select Batch Solution of Marked Combinations and leave the Include an 

Envelope with the Batch checkbox enabled. 

• Click Solve. 

Reviewing Results: 

• Select the Wall Panel Design spreadsheet from the Results toolbar 

 

• To view the different results for wall panels, click on the tabs at the top: 

Wood Wall Axial, Wood Wall In-Plane, Wood Header 
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The Wood Wall Axial results provide the code checks relevant to Axial Loads of 

the wall.  Here we see similar information that was provided for the Segmented 

design described above. 

 

 

 

The In-Plane results provide the code checks for the shear wall behavior of the 

wall. 

 

 

 

The Shear Panel Label describes the shear panels selected for the wall.  The 

designation N/A is shown for the regions because Perforated design is based on 

the entire wall rather than regions. 

• Close the Wall Panel Design spreadsheet 

Let’s take a closer look at the wall by viewing the Detail Report: 

• Click the Detail button  on the left-hand side of the screen. 

• Click anywhere on the wall panel. The Detail Report Summary Report will 
open. 

 

 

 

The Perforated Design Method uses 
the entire wall panel, rather than the 
regions. As a result, the output will be 
per wall panel. Therefore, N/A is 
displayed in the Region column of the 
Code Check spreadsheets. 

Note: The chords are the vertical hold 
down members/posts at both ends of 
every wall for the Perforated Design 
Method. 
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Wall Summary Detail Report 

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

 

 

 

 

General/Geometry/Materials 

The top section of the detail report 

echoes the entire user defined input.  

The Wall H/W Ratio is checked 

against the aspect ratio limits given in 

Table 4.3.4 of the NDS 2018 Special 

Design Provisions for Wind & Seismic 

(SDPWS).  The opening height 

information is given in order to 

calculate the Co.  

 

 

Design Details 

This section displays the selected 

shear panel and hold downs. The 

maximum unit shear is also shown. 

The shear stiffness adjustment factor 

for wall panels is intended to allow 

the user to adjust the stiffness of the 

walls so that they match the APA 

deflection calculations. This 

adjustment affects the stiffness of the 

entire wall. 

You can modify this adjustment factor 

in the Wall Panel spreadsheet. 

 

 

 

 

General/Geometry/Materials 
The top section of the detail report 
echoes the entire user defined input.  
The Wall H/W Ratio is checked 
against the aspect ratio limits given in 
Table 4.3.4 of the NDS 2018 Special 
Design Provisions for Wind & Seismic 
(SDPWS).  The opening height 
information is given in order to 
calculate the Co.  

 

 
 
 
 
 
 
 
 
 

Design Details 
The shear stiffness adjustment factor 
for wall panels is intended to allow 
the user to adjust the stiffness of the 
walls so that they match the APA 
deflection calculations. This 
adjustment affects the stiffness of the 
entire wall.   
You can modify this adjustment factor 
in the Wall Panel spreadsheet. 

 

 

 

 

Cross Section Detailing 
The last section will provide a cross 
sectional drawing of the entire wall 
with all the wall elements shown 
graphically.  The Chord forces and 
Hold Down Forces are the maximum 
values from the LC that governed. 

 



RISA-3D Wood Panel Tutorial 

24 

 

Header Detail Report 
To navigate the Opening Detail Report, you will need to select 
the Opening Design H1 to expand the calculation. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Click  to close the Detail Report or right-click outside of the report to 

close. 

 
 
 

Headers will automatically be created 

and placed above the openings in 

wood walls. 

Within this window you must specify 

design options to design/analyze your 

header. The trimmers are input as well 

but only for the material take off. 

Each header can be designed 

separately with different parameters 

or you can choose to match the 

properties of another Header. 

 

 

 

 

 

 

Criteria/Materials/Geometry 
The top section of the detail report 
echoes the entire user defined input 
from the Wall Panel Editor. 

Envelope Diagrams (Header) 
The next section will display the 
envelope axial, shear and moment 
diagrams. 

 

 

 

 

 

Design Summary 
This section provides the Bending 
and Shear code checks as well as 
governing location and code 
equation combinations.  The code 
design factors are also displayed. 

Note: The Help file within RISA-3D 
and the RISA-3D General Reference 
Guide both provide explicit 
descriptions of nearly all of the values 
in the report. 
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Designing the Wall: Force 
Transfer Design Method 
Let’s modify the wall and change the Design Method to Force 
Transfer Around Openings: 

• We’ll now switch the Design Method to Force Transfer in the Advanced 

Properties in the Properties Panel. 

 

Note: Select Yes when asked to clear the current results. 

Let’s change the drawing grid to locate the openings:  

• Double click on the wall panel to activate the Wall Panel Editor. 

• In the Drawing Tools, click in the box next to the Horizontal (in), clear the 
current entry and type 36,40,36,80 

• In the Drawing Tools, click in the box next to the Vertical (in), clear the 
current entry and type 3@40. 

• Press the Tab key. 

• Toggle the grid display on and off by clicking the         icon. 

 
We’ll need to delete the door opening and delete all the regions. 

• Click on the Delete All Wall Regions            button. 

• Click on the Delete  button and click on the door opening to delete it. 

• Right click to end the command. 

 

 

 

 

Note: The Force Transfer Around 
Openings method relies on 
reinforcement or straps, which are a 
functionality which is limited to 
windows only. 

Thus, to use this method you cannot 
include door openings in your wall 
panel. 

 

 

 

 

 

 

 

 

 

 

 

 

 



RISA-3D Wood Panel Tutorial 

26 

 

 

Now let’s create a window opening: 

• Click on the Openings  icon at the top left of the Wall Panel Editor 

to create an opening. 

• Left click on the bottom left corner (36,40,0),  

• Move the mouse to the top right corner (76,80,0) and left click on the grid 
intersection. 

• Right click to end the command. 

Let’s define the regions for the wall: 

• To define Regions inside the wall for design/analysis of the wood shear 

wall: Select the Generate Wall Regions Automatically           icon. 

 

 

 

• Click on  to exit the Wall Panel Editor. 

With the loads still applied, run the analysis: 

• Click the Analysis and Design  Icon. 

• Select Batch Solution of Marked Combinations and leave the Include an 
Envelope with the Batch checkbox enabled. 

• Click Solve. 

To display the wall panel as shown, be 
sure to use the Wood View Controls to 
toggle the display of the: 

• Wall Studs  

• Chords  

• Sill Plates  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Designing for the Batch solution 
allows us to review the Detail Report 
as well as design for every load 
combination. 
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Reviewing Results: 

• Select the Wall Panel Design spreadsheet from the Results toolbar. 

 

• To view the different results for wall panels, click on the tabs at the top: 

Wood Wall Axial, Wood Wall In-Plane, Wood Header. 

The Wood Wall Axial results provide the code checks relevant to axial Loads of 

the wall. Here we see similar information that was provided for the Segmented 

design described above. 

 

 

 

The In-Plane results provide the code checks for the shear wall behavior of the 

wall. 

 

 

 

The Shear Panel Label describes the Shear Panels selected for the wall. The 

designation N/A is shown for the regions because Force Transfer Around 

Openings design is based on the entire wall rather than regions. 

• Close the Wall Panel Design spreadsheet. 

Let’s take a closer look at the wall by viewing the Detail Report: 

• Click the Detail button  on the left-hand side of the screen. 

• Click anywhere on the wall panel. The Detail Report Summary Report will 
open. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Force Transfer Design uses the entire 
wall panel, rather than the regions so 
that results will be per wall panel.  
Therefore, N/A is displayed in the 
Region column. 
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Wall Summary Detail Report 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

General/Geometry/Materials 
The top section of the detail report 
echoes the entire user defined input. 

 

 

 

 

 

 

 

Design Details 
The shear stiffness adjustment factor 
for wall panels is intended to allow the 
user to adjust the stiffness of the walls 
so that they match the APA deflection 
calculations. This adjustment affects 
the stiffness of the entire wall.  You 
can modify this adjustment factor in 
the Wall Panel spreadsheet. 

This section displays the selected 
shear panel and hold downs. The 
maximum unit shear is also shown is 
comes from the maximum block unit 
shear in the Opening report. 

 

 

 

 

 

 

Cross Section Detailing 
The last section will provide a cross 
sectional drawing of the entire wall 
with all the wall elements shown 
graphically.  The Chord forces and 
Hold Down Forces are the maximum 
values from the LC that governed. 
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Header Detail Report 
 
To navigate the Opening Detail Report, you will need to select 
the Opening Design H1 to expand the calculation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Criteria/Materials/Geometry 

The top section of the detail report 

echoes the entire user defined input. 

 

Envelope Diagrams (Header) 

The next section will display the 

envelope shear and moment 

diagrams. 

 

 

 

FTAO & Opening Straps 

These sections map out the openings, 

and the strap forces Required 

Capacity. The sheathing resists the 

shear forces. The average shear force 

in each block of the wall (numbered 

1~8 as shown in the image above) is 

used as the controlling shear force in 

that location. The maximum shear in 

each of these locations will control 

the design of the wall and will be 

displayed in the Wall Summary Detail 

report. The program uses an area 

weighted average of the Fxy plate 

forces to determine the average shear 

for each block. 

 

Design Details 

This section provides the Bending 

and Shear code checks as well as 

governing location and code equation 

combinations.  The code design 

factors are also displayed. 

Note: The Help file within RISA-3D 

and the RISA-3D General Reference 

Guide both provide explicit 

descriptions of nearly all of the values 

in the report. 

 

 

 

 

 

Criteria/Materials/Geometry 
The top section of the detail report 
echoes the entire user defined input. 

 

Envelope Diagrams (Header) 
The next section will display the 
envelope shear and moment 
diagrams. 

 

 

 

FTAO & Opening Straps 
These sections map out the 
openings, and the strap forces 
Required Capacity. The sheathing 
resists the shear forces. The average 
shear force in each block of the wall 
(numbered 1 thru 8 as shown in the 
image above) is used as the 
controlling shear force in that 
location. The maximum shear in each 
of these locations will control the 
design of the wall and will be 
displayed in the Wall Summary Detail 
Report. The program uses an area 
weighted average of the Fxy plate 
forces to determine the average 
shear for each block. 

 

 

 

 

Design Details 
This section provides the Bending 
and Shear code checks as well as 
governing location and code 
equation combinations.  The code 
design factors are also displayed. 

Note: In the Help file within RISA-3D 
and the RISA-3D General Reference 
both provide explicit descriptions of 
nearly all the values in the report. 
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Conclusion 

If you have completed the tutorial you should now be familiar with modeling, analyzing and designing wood wall panels 

in RISA-3D. In addition to wood wall panels, RISA-3D has wall panels in masonry and general materials. To learn more 

about the other materials or if you wish to know more about specific features, you can refer to the RISA-3D General 

Reference Guide or the Help from within RISA-3D. 

If you have any questions, comments or suggestions feel free to email us at support@risa.com or call us at 949-951-5815. 

Thank you for choosing RISA! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


